
 
 

 
 
 
 

1

 

Magi-Cut Express  
Guide 

  
 

Revision 1.00 
 Contents 
 
1.  Working with Express ....................................................................................................................................2 
2.  Setup (install) ...............................................................................................................................................17 
3.  Parameters ..................................................................................................................................................28 
4.  More about Cutting lists ...............................................................................................................................32 
5.  More about Review runs ..............................................................................................................................38 
6.  File Management .........................................................................................................................................53 
7.  Backup and Restore ....................................................................................................................................55 
8.  Access to Help .............................................................................................................................................57 
 
 

 Copyright 2023 Magi-Cut Software Ltd. All rights reserved. 
 
No part of this document may be reproduced or transmitted in any form or by any means, electronic or 
mechanical, for any purpose, without the express written permission of Magi-Cut Software Ltd. 
 
This Manual and the Software referred to are licensed to the Company or Person identified by the Licence 
and shown on the Startup screen. Please make sure that you have read and understood the Software 
Licence Agreement provided before you install and use the software.  
 
 



 
 

 
 
 
 

2

1.  Working with V12 Express 
 

The V12 Express program is a simple and straightforward way of generating cutting patterns for a 
cutting list. It is designed for the smaller workshop using a sliding table saw or vertical saw and is focused on 
producing efficient cutting patterns from lists of part sizes and available materials (boards). 
 
 It is Windows software running on a single PC at a time. 
 
Express - at a glance 
 

  
This is how to work with Express:- 
 
•  Create a New cutting list 
 
•  Enter the part sizes, material and quantities required 
 
•  Enter the available board sizes 
 
Or Import the part details from  file 
 

Optimise 
 
•  Review and print/export the results 
 
•  Use the Cutting instructions to set the saw 
 
What is Optimising? 
 
The aim of the optimiser is to produce the most efficient patterns in terms of cost.  This depends on:- 
 
- Cutting list sizes 
- Constraints on cutting (trims, saw blade thickness) 
- Board sizes available 
- Material costs 
 
The process of optimising weighs all these factors and produces a set of cutting patterns.  
 A tour of V12 Express 
 
As an introduction to the software we enter a cutting list, optimise it, and look at the results. 
 
If Express is not yet installed - look at the section: 'Setup (install)' 
 
(It may be helpful to read through this guide before installing the software to become familiar with the overall 
operation of the program). 
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To run the program click on the icon on the desktop 
 
The first screen is the 'Splash' screen which appears for a few moments. 
 

  
 The program moves automatically to the Main screen.  
 
Main screen 
 
This is the command centre of the system. Access all the options and choices from here. 
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Note - A set of demonstration data is included when the program is setup. 
 
At the far left is a stacked ToolBar (Shortcut Bar) giving quick access to each section of the program. 
 
At the centre left is a tree/index showing the various options and existing data.  
 
There is also a top toolbar and menu options to access all the other program features. 
 
The other section of the screen optionally shows an information panel and a pane showing the contents of 
the currently selected file, for example, a cutting list. 
 

  Measurement mode - The program works in millimetres, fractional inches, or decimal inches. The 
operation of the software is the same in each case except that fractional inches are displayed and entered in 
fractional format (44 x 61-1/4, 96 x 48-1/2).  
 
This tour uses: Millimetres. 
 
Note - arrange the screen to suit your way of working with the View menu option and by adjusting the size of 
each pane with the mouse (place the cursor at the edge of a pane to display the grab handles). 
 
First time - If using the software for the first time - check the Serial number is correct and click on the Licence 
button to check the details of the software licence agreement. These are options on the Help menu (Help - 
About, Help - Licence agreement) 
 
Enter a cutting list 
 
To enter a list of sizes:- 
 
At the tree open up the 'Cutting lists' branch (click on the + symbol). 
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•  Double click on the New... option 
 
The program moves to the Cutting list screen and shows a new blank list.  
 
At the 'Title' box enter a title for the list. 
 

  
(If the 'Title' box is not visible - select: View - Properties to switch on the Title box) 
 
•  Move to the line labelled 1 in the 'Parts' section (use the mouse or Tab) 
•  Enter the part details including the quantity required 
 The details to enter for each part are as follows:- 
 
Description - Any code or short description of the part.  
 
Material code - A code for the board material to use for that part. 
 
Express uses this to match up the parts with the available boards in the board list. Each board size and 
material needs a unique code.  For example:- 
 MEL-CHIP-18MM     (melamine faced chipboard 18mm thickness) MED-DEN-FIBRE-18  (medium density fibre board 18mm thickness) 
 
Sizes - the length and width of the part.  
Quantity - the quantity of the part required for this job 
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Grain - the material grain of the part  Y - grained (grain runs with length of the part) N - no grain (part can be placed either way) X - grained (grain run across the width of the part) 
 
White melamine typically has  no grain but Teak laminate is grained. The program uses the grain setting to 
make sure that each part is correctly laid out on the board and where the grain needs to run along the length 
of the part it does so. 
 
Global line - the line at the top of the list is called the global line. This can be used to provide a common 
answer for every part in the list for a given field - in this example the over and under percentages are set to 0 
percent for all parts as they are not used in this tour. 
 
After entering a few sizes the 'Parts' section should be similar to the following. 
 

  
We can now enter some board sizes. 
 
•  Move to the Boards section (click on row 1 with mouse or Ctrl Tab) 
•  Enter details of the available boards 
 
At the cutting list the material codes used were:- 
 MFC18-TEAK MFC18-EBONY HARDBOARD-4MM 
 
The details to enter for each board are:- 
 
Board - a board code or description 
 
Material - a material code  
 
Express uses this to match up the parts with the available boards in the board list. Each board size and 
material needs a unique code 
 
Sizes - the length and width of the board 
Information - any extra details about the board (e.g. supplier, quality) 
Quantity - the number of each board size in stock 
 
Cost - the cost per square area (metre) of the material. 
 
Enter an accurate cost as the program uses this to assess the pattern layout. 
 
Grain - the material grain of the board 
 Y - grained (grain runs with length of the part) N - no grain (part can be placed either way) X - grained (grain run across the width of the part) 
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Save the Cutting list 
 
When data entry is finished - save the cutting list. To do this:- 
 

 - Select the Save symbol 
 
The program prompts to save the cutting list to a file. 
 
•  Enter a file name 
 

  
•  Select OK to confirm the save 
 
Note - the title can be changed here if necessary 
 
Import - cutting list 
 
In the cutting list program, there is an Import option (File menu and toolbar icon). Selecting this will bring up a 
dialog showing all the files in the current path. The path can be changed via the Change path button at the 
top of the dialog. Importing the data can provide an alternative to inputting all of your cutting list data 
manually.  
 
An Import file can be either a text based file (CSV) or an Excel file (XLS or XLSX). 
 
Once a file is selected and the Ok button is pressed the following dialog will appear as follows: 
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Note - If the wrong filename has been specified then the previous button can be used to go back and select a 
different filename. 
 
The first parameter is used to specify if there any header lines in the import file that need to be skipped. 
 
The second parameter is what is the separator character (usually a comma, and disabled for Excel based 
files). 
 
At this point each relevant column can be assigned to a column in the cutting list. This is done via the combo 
box at the top of each column. Once a column is defined it will turn cream coloured. 
 
Once all the relevant columns have been specified, the Ok button can be selected and the file will be 
imported in. 
 
Notes: 
 
- The column details will be stored and reused for subsequent imports so they do not need to be set the next 
time. 
 
- Excel imports will only import from the 1st sheet in the file. 
 
- Import will automatically discern if a txt file is ASCII or UNICODE based. 
 
- The import process will utilise the current locale decimal separator and convert it to a decimal point. 
 
Export - Cutting list 
 
In the cutting list screen, there is an Export option on the file menu. If a cutting list is on screen and this option 
is selected then the following folder selection dialog will appear: 
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Once a folder is selected a CSV file named after the current cutting list will be generated in that location and 
the following message will be displayed: 
 

  
Note - If the file already exists, then an overwrite Y/N dialog will be displayed first. 
 
The format of the CSV would have lines as follows: 
 
description,material,length,width,qty,grain,edging,fixed1,fixed2,fixed3 
 
Note - the separator between each value is the same as the one specified for import cutting lists. The decimal 
point for the length/width values is set based on the current PC's specific decimal separator. 
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Optimise 
 
Once you have entered a cutting list you are now ready to optimise.  
 
Along with the Part and Board sizes the program also requires values for the cutting constraints, for example, 
the 'Saw blade thickness', 'Size of trims' etc. These are set via the 'Optimising parameters'. 
 
There is a default set of parameters which the program uses automatically - these are used for this tour.  
 
(There is a section on how to adjust the parameter values later in the guide). 
 
At the cutting list screen:- 
 

- Select the optimise symbol 
 
Express starts the optimisation.  
 
A small window appears while the optimisation is in progress. Use Cancel to abandon the optimisation. 
 
Express shows the results.  
 
The first screen shown is an overall summary of the optimisation called the 'Management Summary'. The 
optimisation results (a set of patterns) is also called a 'run' and this section of the program for looking at the 
results is called 'Review runs'. 
 

  
Once the optimisation is complete the results are stored and can be reviewed and printed as required. 
 
The Management summary report shows the overall statistics for the run. For example:- 
 Number of parts produced 
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Number of boards used Overall cost Overall yield 
 
Use the Navigation bar to look at the other reports. 
 

  
The other reports are:- 
 Part summary Board summary Pattern summary Input summary Material Summary Run Summary Pattern preview Patterns 
 
The stacked toolbar at the left can also be used to access the reports and to view the patterns. 
 

 - Click on the pattern preview symbol 
 
A thumbnail preview is shown. 
 

  
The preview shows all the cutting patterns grouped by material code. 
 
•  Double click on a thumbnail to see the full pattern 
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The waste areas are shown with hash lines (or via a colour). The patterns can include recuts and head cuts 
(as shown below). 
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The tab bar at the foot of each pattern shows the other pattern information, Part sizes and Cutting 
instructions. 
 
The cutting instructions are for a sliding table saw and can be used to set the saw for cutting. 
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Export - Summary 
 
In review runs the file menu has an Export current summary sub-menu with the same options: 
 
This enables you to create files that you can use outside of the software on a report by report basis. 
 
 PDF 
 XLS 
 XLSX  
 
Selecting any of these will bring up the folder selection dialog and after export the following dialog will be 
displayed: 
 

  
The export filename will be named as follows: 
 
<runname>-<summary name>.[PDF|XLS|XLSX] 
 
e.g. basic cutting list-management summary.XLS 
 
Exporting a pattern drawing to XLS or XLSX will create a <runname>-<ptnnum>.jpg file 
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Note - Export to XLS/XLSX files is not available for Pattern preview. 
 

 - select exit to leave Review runs 
 
The program returns to the Main screen. 
 
At the main screen open up the 'Optimisations' branch of the tree.  The recent optimisation is now in the list. 
 
This run can be reviewed at any time by selecting the item. 
 

  
Note - if the parts or boards are changed after an optimisation the results are no longer valid and the lists 
should be optimised again. 
 
Export - run 
 
On the main menu under the file menu there is an Export Runs sub-menu with the following options: 
 
 PDF 
 XLS 
 XLSX 
 
This enables you to create a number of files in one go that can be used outside of the software (these are 
similar to the files you can export from within review runs individually). 
 
After selecting one of these a dialog will appear to select a run and after the run is selected the following 
dialog is shown from where you can select which summaries appear in the export file. 
 

  
Initially this dialog will have all the possible summaries for the export type checked, but if any are unchecked 
then the next time export runs is done, it will reflect those changes. 
 
After this dialog is the folder selection dialog and after that the export takes place and the following dialog is 
displayed. 
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A PDF, XLS or XLSX file will have been generated in the folder selected for the selected run. 
 
The PDF file will have page breaks between each report. The excel files will have summaries on separate 
sheets and the folder will also contain JPG files for the pattern drawings. 
 
These JPG file will be names as follows: 
 
<runname>-<ptnnum>.jpg 
e.g. Basic part list-0001.jpg 
 
End of Tour 
 
The tour above has shown the principal operations of V12 Express and how to use it. The later sections give 
more details about the program. 
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2.  Setup (install) 
 
V12 Express is downloaded as a single file named:- 
 
Magi-Cut V12 Express Setup.exe 
 
- Click on this program to start the setup. 
 
Follow the setup (install) instructions carefully. When finished the software and demonstration data is ready 
for use. 
 
The Setup program displays the first screen:- 
 

  
The above screen is NOT shown if Express is already installed on the PC.  
 
Instead the program prompts to update/repair the existing installation. 
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•  Select Next to continue  (Cancel to abandon) 
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The screen shows the Licence agreement for the UK. Use the scroll bar to navigate up and down the 
document (use Print to make a copy) 
 
•  Check the radio button to accept the agreement 
 
The agreement must be accepted for setup to continue 
 
•  Select Next to continue 
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The next screen shows the version number and minimum hardware requirements for the program (use the 
Print button to print a copy - if required). 
 

  
•  Select Next to continue 
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Then you will be asked for the location you wish to install the software (the default is shown) 
 
To select another folder use the Browse button. 
 
 

  
•  Select Next to continue 
 
The installer will then prompt you for the program group name (again the default is shown). 
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•  Enter the name for the program folder (if required) or select a different folder. 
 
•  Select Next to continue  
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The Setup program proceeds with the installation. 
 

  



 
 

 
 
 
 

24

When Setup is finished the final screen is displayed. 
 

  
•  Select Finish to close the Setup program 
 
The program displays the program group.  
 

  
A shortcut is installed on the desktop and the program group is added to the Windows 'Programs' bar (at the 
Windows 'Start' button) 
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•  Close the program group 
 
Note - To uninstall use the Add/Remove (Program features) option at the Windows control panel. There is no 
option in the program group to remove the program. 
 
Security - For the trial version the first screen shows the remaining days for the trial; there are other options 
for purchasing the program. Press the 'Continue' button to move to the main screen. For the purchased 
system the program moves directly to the main screen; it is protected by a software licence. 
 
Program does not run 
 
If the program does not run there are only a few main causes. 
 
- Program was not installed correctly 
- Hardware is below minimum requirements 
- The Trial version has expired (it runs for a limited number of days) 
 
Program setup problems 
 
It may be the program setup failed (this is quite rare unless the setup was cancelled) 
 
- Re-try the install (in this case install to a different location on the PC) 
 
The state of the program can be checked (if the Setup finished Ok) by running the 'Check' program.  
 
Use Windows Explorer to move to the program directory (where the program was installed e.g. C:\Magi-Cut 
V12 Express).  
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Double click on the program 'Check.exe' to run the system check.  
 
Alternatively select the 'System Check' option from the Program group on the Windows 'Start' button. 
 

  
Help 
 
If there are problems running the program the help can still be accessed. To do this:- 
 
Move to the directory where the program is installed 
Double click on the program 'Check.exe' to run it 
Click on the Help button (this is the full help for V12 Express) 
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Minimum hardware 
 
The program does NOT run on any PC below the minimum specification. The minimum specification is:- 
 · Processor speed 2Ghz · Memory 2Gb (400Mb free) · Hard disk 20GB free · Display 1440 x 900 or higher  The supported operating systems for this version are:  · Windows 8 (32bit and 64bit versions) · Windows 2012 Server x64 Editions · Windows 8.1 (32bit and 64bit versions) · Windows 2012 Server R2 x64 Editions · Windows 10 (32bit and 64bit versions) · Windows 2016 Server x64 Editions · Windows 2019 Server x64 Editions · Windows 11 · Windows 2022 Server 
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3.  Parameters 
 
For effective optimising the program should be set up to allow for the correct measurement mode, saw blade 
thickness, and trims etc. These parameter values can vary for different jobs and between companies. 
 
Use the 'Parameters' options to set these values. 
 
The parameters are set to reasonable default values when the program first runs but it is important to check 
all these values and adjust them where necessary to reflect your way of working.  
 
There are only a few parameters to consider. 
 
System parameters 
 
These are basic settings for the program.  At the main screen:- 
 
•  Select: Parameters - System parameters 
 

  
•  Select the measurement mode to work in. 
 
For Express this is typically Millimetres. 
 
•  Enter a name for the Company 
 
This name is shown on the screen and in the header/banner of most printed reports. 
 
Note - These parameters are usually only set once and rarely need to be considered again. 
 
Optimising parameters 
 
Optimising parameters are important as they set the saw blade thickness, trims and type of cutting allowed. 
To adjust the default values for the optimising parameters, at the main screen:- 
 
•  Select: Parameters - Optimising parameters 
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Work through the values on the first page and set the required values for the saw blade thickness, front and 
rear trim, and retrim value.  
 
The picture at the right gives an overview of what the parameter does (select Help for further details). 
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The second tab shows the 'Rules'. These can be used to set the cutting style. 
 

  
For example, recuts can limited to 'single recuts only' and the number of head cuts allowed can be restricted 
to '1'. 
 
These default values apply to all optimisations BUT there is also an option to adjust the values for each 
cutting list  (at the cutting list screen). This is may be necessary, for example, to change the trims for one type 
of material, or to set 'no head cuts' for an optimisation. To do this:- 
 
- Move to the required cutting list 
 

  
- Click on the parameters button 
 
The program displays the Optimising parameter screen (for the cutting list) 
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- Adjust the required values 
 
Any changes (at the cutting list)  only apply to the cutting list chosen 
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4.  More about Cutting lists 
  
There are several options for searching, sorting and for changing the view of the cutting list. 
 

  
These options can be useful when dealing with larger lists or where not all the fields (columns) are required. 
 
Find 
 
To locate an item in the list (for example, a part description or material code). 
 
•  Click on a cell in a column 
•  Select: Edit - Find (Ctrl F) 
 
The program displays the Find dialog. 
 

  
•  Enter text to search for 
•  Select the [ Find Next ] button 
 
The program moves to any found items. 
 
The search is only for the current column and only applies to the list the cursor is located in;  Parts and 
Boards are searched separately. 
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Sort 
 
The list can be sorted by material, or by length, or by a combination of these. At the Cutting list screen:- 
 
•  Move to the 'Parts' section 
•  Select: Edit - Sort 
 
The program displays a dialog to select the part fields to sort by. 
 

  
•  Check a box to select a field 
 
The sort can be based on more than one field. 
 
•  Select OK to confirm 
 
Note - A sort can also be applied to the Boards section (move to the Boards section and select: Edit - Sort). 
 
Save and Copy lists 
 
In some cases it is useful to save an existing list and use this as the basis for a new list. For example, where 
many of the part details are the same but the quantities are different. There are two ways of doing this. 
 
Save As 
 
•  Select: File - Save As 
 
The program prompts for the name of the new list. 
 
Take care when using this method because if the existing list is already optimised opening a list gives the 
warning message:- 
 
Patterns exist - changing list deletes patterns 
 
It is Ok to open the list but make sure no changes are made. 
 
Merge lists 
 
•  Create a NEW cutting list:- 
•  Move to the first line 
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•  Select: Edit - Merge 
 
The program prompts for the name of the cutting list to merge in. 
 

  
•  Enter the list name  (or use the List button to select available lists) 
•  Enter the quantity of the list to merge in. 
 
The merge applies to the Parts section and Boards section separately. Move to the Boards section to merge 
in Boards (Edit - Merge). 
 
Note - Merge can also be used to add one list to another. 
 
View menu 
 
Use the View menu to alter the style and appearance of the cutting list 
 
For example, to hide columns:- 
 
•  Select: View - Columns 
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•  Un-check a column to hide it. 
 
In the example below 'Grain' and 'Quick edging' columns are hidden. 
 

  
Edit Parts and Boards 
 
The Cutting list operates like a spreadsheet. Use the standard 'Windows' options to cut and paste data. 
These options are on the Edit menu. 
 Edit - Cut (Ctrl X) Edit - Copy (Ctrl  C) Edit - Paste (Ctrl V) 
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Edit - Undo (Ctrl Z) Edit - Clear (Del)  Edit - Insert line (F6) Edit - Delete line (F7) 
 
Cells, rows or blocks of data can be copied. When copying more than one cell make sure that the selected 
block and the area to copy to match exactly in terms on the number of columns and rows. 
 
It is also possible to copy data from an external spreadsheet. In this case the columns in the spreadsheet 
must match the columns as set in the Cutting list. For example:- 
 

  
The data can be pasted into a new or an existing cutting list. 
 

  
Note - if copying from V12 Express to a spreadsheet any hidden columns are automatically included in the 
copy - allow for this in the spreadsheet format. 
 
Global line 
 
The Global line is the line at the top of the list of Parts and list of Boards. 
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If there is an entry in this line the entry applies to every item in the list. This saves typing effort where the 
value is the same for every part, for example, if all parts are the same material. The lines below the global 
line are greyed out and cannot be changed. 
 
To remove a global entry; delete the entry at the global line and move off the cell. 
 
Print - Cutting list 
 
To print the current list:- 
 
•  Select: File - Print (Ctrl P) 
or 

Select the ToolBar option 
 
The program prompts to choose the data to print. 
 

  
- Check the options to print parts, boards or both. 
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The following example shows a print including Parts and Boards. 
 

  
The other Print options are:- 
 
•  File - Print preview (view the printout on-screen before printing) 
•  File - Print setup (change paper size, orientation, etc.) 
 
Using Board list with Merge 
 
Where there is a fairly standard and limited set of board sizes it can be useful to set up a full list of boards in 
a cutting list and use Merge (at the Board list) to copy the list of boards into other cutting lists as required. 
 
To do this:- 
 
•  Select any cutting list 
•  Select: Save As 
•  Enter a name for the new list 
 
(for example, 'Standard') 
 
- Enter the standard board sizes 
 
At any cutting list (boards section) where some or all of the standard boards are required select 'Merge' to 
merge in the 'Standard' list. Adjust the quantities or boards available as required. 
 
It does not matter if the standard list contains boards with materials that are not in the parts section - these 
boards are ignored. 
 5.  More about Review runs 
 
The 'Review runs' options are used for looking at the cutting patterns (optimising results). They show a set of 
summaries, the full set of patterns and cutting instructions. 
  
To look at any optimised run, at the main screen:- 
 
•  Open the 'Optimisations' branch of the tree 
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•  Double click on a run to view it. 
 
The first report shown is the Management Summary 
 

  
Use the navigation options and/or the stacked toolbar at the left to see the other reports and patterns. 
 
Customising reports 
 
Each report can be customised. The items that can be changed are:- 
 
- Report content 
- Report  format (font style and size) 
- Report layout (column widths, grid lines etc.) 
 
To customise the 'On-screen' report:- 
 
•  Move to a report (e.g. Part summary) 
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•  Select: Settings - Report settings 
or 

 Select the Toolbar symbol 
 
The Report layout dialog is shown. 
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Content 
 
These boxes show the available fields on the left and the fields already chosen for the report on the right. 
 
•  Select an item and use the arrow buttons to move the item to and from the report. 
 
In the following example some fields are removed from the report. 
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The report now looks like this:- 
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Line type 
 
This box shows the different sorts of information on the report, for  example, Report header, column 
headings, data. The style of each of these can be changed. 
 
- Click on Line type 
- Click off the check box (Use default) 
- Select the Font and Background buttons to change the font and background 
 
In the example below the 'Summary title' font and background are changed. 
 



 
 

 
 
 
 

44

  
The report is now as follows:- 
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Column widths 
 
To change the column widths:- 
 
- Click off the 'Use default' box 
- Select the type of column width 
 User defined Auto fit to contents Auto fit to display 
 
In this example the column width is set to 'User defined'.  
 
Whilst the grid widths can be changed at this dialog it is often easier to do this at the Report screen via the 
options on the 'View' menu. 
 
Using the View menu to customise reports 
 
There are several options at the 'View' menu to help customise the report.  For example:- 
 
To manually change the column widths. 
 
•  Turn on the Grid labels (these act as grab handles for the columns). 
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•  Move the mouse over the junction of a grid label to alter the column width 
•  Hold down the mouse button to drag the column to change the width 
 
In the following example the column widths have been altered. 
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The view menu can also be used to add grid lines. 
 
•  Select: View - Grid lines 
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Default report settings 
 
On the report settings dialog there is a box labelled 'Use default'. If this is checked the default settings for a 
report are used. These defaults apply to ALL the reports where this box is checked. 
 
To change the default settings themselves, at any report:- 
 
•  Select: Settings - Default settings 
 
The default settings are shown. 
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Note - The content of each report is also set as a default - this default is set by the program and cannot be 
changed. 
 
Printing reports 
 
To print a report (or pattern). 
 
•  Move to the report/pattern 
 
- Select: File - Print (Ctrl P) 
or 

Select the ToolBar option 
 
This prints the current report. 
 
To print all the reports and/or patterns. 
 
•  Select: File - Print summaries 
 
The program prompts with a dialog to select the items to print. 
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•  Use the arrow buttons to move the reports from 'Available' to 'Chosen'. 
 
The program retains the choices for future sessions. 
 
(The default reports to print are set at the 'Review runs Parameters' dialog). 
 
There are options on the File menu to alter the Page Setup and Printer Setup. 
 
•  File - Page setup 
•  File - Default Page setup 
 
The page setup can apply separately to each report. 
 
•  Move to the report 
•  Select: File - Page setup 
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These options control the paper size, orientation and basic report items such as the banner and page 
numbers. 
 
- Check the 'Use default' settings to apply the default settings. The default settings apply to all reports where 
'Use default' is checked. 
 
The default settings can be changed via the option: File - Default page setup. Any changes to the default 
settings apply to all reports using the default settings. 
 
File - Print setup - This is not often needed since the printer can be changed at the standard Print dialog 
which always pops up before printing reports and the page layout is best set at the 'Page setup' or 'Default 
page setup' dialogs. 
 
Review runs parameters 
 
The operation of Review runs can be customised via 'Review runs parameters'. At the Review runs screen:- 
 
•  Select: File - Parameters 
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There are options to alter the pattern display and how patterns are shown (e.g. monochrome or colour). 
 
The Reports can be set to show waste percent or yield and whether large values are rounded or not. 
 
The Review runs parameters help describes each setting in detail.  
 
The following example shows the pattern diagram using colour codes rather than monochrome. 
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6.  File Management 
 
The File management options are for organising and maintaining the files created by Express. At the main 
screen:- 
 
•  Select: File - File Management 
or 

 Select the Toolbar option 
 
The file management screen is displayed:- 
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At the left the tree shows the different types of file used by Express. 
 Cutting lists Optimisations 
 
- Click on a category to see the files 
 
The pane at the foot of the screen shows the contents of the currently selected file. 
 
Copy files 
 
•  Select type of file in the left pane 
 
•  Select one or more files 
•  Select: File - Copy 
or   

Select the Toolbar option 
 
The program prompts to select a file name and/or directory to copy the files to. 
 

  
Use the list box to select a path 
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•  Select OK to finish 
 
Delete Files 
 
To permanently remove files. 
 
Select type of file in the left pane 
 
•  Select files 
•  Select: File - Delete 
or  

 Select the Toolbar option 
 
The program prompts to confirm delete. 
 
Notes 
 
For optimisations (runs) the program deletes all the files associated with the run. A run consists of several 
different files as well as the main run file. 
 Example1.ctt - cutting list Example1.brd - board list Example1.ptn - patterns Example1.btc - internal file Example1.cut - cutting instructions 
 
Print (File management) 
 
To print the current list of files, at the File Management screen:- 
 
•  Select: File - Print  (Ctrl P) 
or 

Select the Toolbar symbol 
 
The program prints the current list. 
 
To set up the printer: Select: File - Print setup 
 
The program displays a standard Windows dialog to change the printer settings. 
 
To print with a preview: Select: File - Print Preview 
 7.  Backup and Restore 
 
Once the program is in regular use - make sure the System Administrator includes the Express directory in 
the regular system backups. This is the directory that was set up during the install process, for example:- 
 c:\Magi-Cut V12 Express 
 
The program and all the data are typically stored in this directory/folder with data and other information in 
sub-directories, for example:- 
 c:\Magi-Cut V12 Express\Data 



 
 

 
 
 
 

56

  Backup 
 
The program includes a 'Back up' option. This takes a copy of the current data and stores it in a single 
compressed file. 
 
'Back up' can be used to take a snapshot of the data for archiving or testing and as a regular back up - but it 
should not replace a regular back up set by the System Administrator. 
 
At the main screen:- 
 
•  Select: File - Back up 
or 

Select the Toolbar option 
 
The Backup dialog is displayed. 
 

  
The 'Path for back up' defaults to 'My documents'.  Use the list box to select an alternative path. 
 
The 'File name' box contains a default name based on the date and time. Click on the 
field to edit the name or enter a different name. 
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 •  Select OK to confirm 
 
The data is backed up to a single file (e.g. 2023-06-23 Magi-Cut V12 Express Backup.bkp ). This is a 'zipped' 
file containing all the files in a compressed form. 
 
When back up is complete the program prompts with a message showing number of files and 
overall size. 
 
•  Select OK to finish 
 
Note - The 'Back up' option is also available at the File management screen. 
 Restore 
 
To restore backed up data. At the main screen:- 
 
•  Select: File - Restore 
 
(If there are no back up files in the current back up directory the program warns with the message 'No entries 
found'  - select OK to continue). 
 
The program prompts with a list of Back up files. 
 

  
- Use the Browse button to choose from a different back up directory. 
 
•  Select OK to continue 
 
Any existing data is replaced. 
 
The program automatically takes a back up of the existing data before replacing it. 
 
•  Select Yes to continue 
 
When the restore is complete a message 'Restore finished' is shown on the screen. 
 8.  Access to Help 
 
There are a range of Help options when using Express. 
 
At each screen or dialog there is typically a help button and usually Help choices on 
the menu. 
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 - click the help symbol 
 

 - choose an option from the Help menu 
 
Where the cursor is located at a field or check box press F1 to bring up help about 
that item. 
 

 - press [ F1 ] for help 
 
On most dialogs a help button is provided. 
 

 - click on button for more details 
 

  - Place the cursor over an object to view a tooltip 
 
Help is shown in a Window that sits on top of the program window. The Left pane shows 
the Contents and the Right pane the current topic. 
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The Toolbar and Help menu at the top of the Help screen gives access to other options, for example, Print. 
 

 On most topics there is a 'See also' button - this shows other links relevant to the topic. 
 
- Print any help topic by using the Print option from the menu at the top of the screen. 
 
Errors 
 
If a problem occurs this is typically reported as an Error message on-screen. For example:- 
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When working with cutting lists, runs etc. problems are often caused by missing or wrong data. In these 
cases the start of the message indicates the type of problem and the rest of the message describes the 
missing data. 
 

 - select the Help button for details of the error 
  

  
All the error messages are included in the Help file and can also be accessed from the Help menu or by 
searching the help. Each error also has a fixed number to help identify it. 
  
- To search for a phrase like: Data not correct - No boards enclose the phrase in quotes: "Data not correct - 
No boards" 
 
- Some errors messages can have several different causes - check the topic carefully to identify the correct 
cause. 
 
After the error message 
 
Where the error is advisory the program may continue to complete the operation - in this case check the 
results carefully. 
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In most cases the error prevents the operation and the program moves back to the previous screen. 
 
System Check 
 
This option performs basic checks on the hardware, operating system and Express installation. 
 
It is useful for investigation of problems with the software not running and problems with the Licence. 
 
At the main screen:- 
 
•  Select: Tools - System Check 
 
The System Check Report is displayed 
 

  
Some of the individual checks are available on the Check menu.  
 
The Initial screen shows the following information. 
 Version number and directory checked Program and language status Licence details System details Memory details Disk drives 
 
If an item shows Ok the item is Ok for running the program 
 
If there is an X check the item as it may be a problem 
 
To print a system check report:- 
 
•  Select: File - Print 
or 
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 - Select the print button 
 
Notes 
 
The System check option can also be run as a stand-alone Program. It is in the program directory (where the 
program was installed) and is named 'Check.exe' - this can be useful where Express is not running. The 
'Check' program does not require a licence. 
 


